DEFORMABLE MIRROR MODELING SOFTWARE.................................................................1
Version 2.0 .........................................................................................................................1
Updated March 2004 ..............................................................................................................1
INTRODUCTION ................................................................................................................3
DEFORMABLE MIRRORS ......................................................................................................3
Two-Layer Deformable Mirrors ..............................................................................................3
GETTING STARTED ...............................................................................................................4
SETTING-UP A DEFORMABLE MIRROR ...............................................................................10
Quick Actuator Setup ...........................................................................................................11
Loading or Saving Material Characteristics .........................................................................11
MODELING MIRROR PERFORMANCE ...............................................................................11
Membranes ...........................................................................................................................12
Plates ...................................................................................................................................12
Generating Influence Functions ..........................................................................................13
DEFORMABLE MIRROR GRAPHIC USER INTERFACE (DM GUI) ...........................................13
ANALYSIS AND CHARACTERIZATION .............................................................................13
Surface Plotting ....................................................................................................................14
Zernike Decomposition .......................................................................................................14
Resonance Frequency Calculation .....................................................................................16
Singular Value Decomposition (SVD) ..................................................................................16
Far-Field Intensity Profile ...................................................................................................16
Spatial Frequency Creation and Matching ..........................................................................17
MAIN MENU OPTIONS .....................................................................................................18
KNOWN SOFTWARE LIMITATIONS ..................................................................................18
REFERENCES .......................................................................................................................19

Table Of Figures

Figure 1 - Cross-sectional illustrations of two-layer deformable mirror architectures.............3
Figure 2 - Deformable Mirror Nomenclature .........................................................................4
Figure 3 - Main GUI Overview Screen ..................................................................................5
Figure 4 - Specifications Tab Screen ....................................................................................6
Figure 5 - Membrane Tab Screen Shot ................................................................................7
Figure 6 - Alternate Plot using Interferogram ........................................................................8
Figure 7 - DM GUI Tab Screen Shot ...................................................................................9
Figure 8 - Specifications Tab ...............................................................................................10
Figure 9 - Dialog box for setting up the rectangular array of actuators (top), and the hexagonal array of actuators (middle), and the concentric ring actuators (bottom). ...........................................11
Figure 10 - Membrane Tab ..................................................................................................12
Figure 11 - The DM GUI Tab ..............................................................................................13
Figure 12 - Surface plotting area ..........................................................................................14
Figure 13 - Zernike Tab .......................................................................................................14
Figure 14 - Zernike Decomposition Pictorially ...................................................................15
Figure 15 - Miscellaneous Tab ...........................................................................................16
Figure 16 - Far-field tab and an image of the far-field intensity distribution .........................17
Figure 17 – Spatial pattern that has been created across the mirror surface .........................18
**Introduction**

Intellite’s deformable mirror modeling software, DMModel, was developed to aid in the design of deformable mirrors based on our patented micro-machining technology, but is useful for modeling virtually any electro-statically actuated continuous membrane deformable mirror. The software allows complete design and analysis of electrostatic mirror architectures. The DMModel Graphical User Interface (GUI) allows the user to easily define and visualize mirror designs. Once mirror design parameters are defined, influence functions are derived for each of the actuator pads to allow determination of mirror surface shapes based on applied actuator voltages. The fundamental spatial modes of the mirror design are found using Singular-Value Decomposition (SVD). Actuator voltages may be applied manually or derived by fitting the mirror surface to a defined wave-front aberration. Wave-front aberrations for testing mirror correction can be defined using Zernike polynomial terms or as a single two-dimensional spatial frequency. Aberration correction and residual aberrations are determined by performing a fit of Zernike terms to the resulting mirror surface. Finally, far-field and Fresnel intensity diagnostics may be calculated for any mirror surface as an additional measure of wave-front correction fidelity.

**Deformable Mirrors**

DMModel models two basic deformable mirror (DM) architectures. This section will introduce these architectures and how to specify mirror parameters to define them.

The current version of DMModel (Version 2.0) models two-layer deformable mirrors only. The previous version of DMModel also supported three-layer designs. Intellite is no longer developing mirrors with three-level architectures. Thus, the three-layer software has been inactivated in this version to simplify operation. Figure 1 shows a cross-sectional view of the two different types of two-layer deformable mirrors supported by DMModel. Figure 2 illustrates nomenclature describing several of the important mirror design parameters.

**Two-Layer Deformable Mirrors**

Two-layer deformable mirrors, named for the mirror layer and the electrostatic pad layer, are characterized by the inability to provide any active restoring force. The most common two-layer deformable mirror is a simple membrane deformable mirror, like those developed by Perkin-Elmer in the 1970’s and by NASA’s Jet Propulsion Laboratory in the 1990’s. Another type of two-layer deformable mirror is one in which pillars are attached to the reverse side of the mirror, like that developed at Stanford in the 1990’s. The attachment of the pillars facilitates fabrication while helping prevent snap-down damage and creates small stiff regions of the membrane. These stiff sections are modeled in DMModel using Finite Element Analysis (FEA) to define the mirror influence functions.

**Figure 1** - Cross-sectional illustrations of two-layer deformable mirror architectures.
Getting Started

DMModel™ allows a micromachined deformable mirror customer to model their mirror and understand how the membrane-based mirror will distort and perform under varying electrostatic loads. The modeler can adjust the size, actuator placement, voltages, membrane material, thickness and stress parameters.

Many advanced features are built into the program such as fitting the distorted membrane to Zernike coefficients and predicting how accurately the user’s mirror will correct for their particular aberrations or distortions.

There are a great variety of display options that allow the user to visualize their membrane while activated, including a simulated interferogram option that should approximate the image obtained from a laboratory-based Michelson (or other) interferometer when experimentally measuring actual mirror displacements. While the operational details of the code are long and involved, this section is meant to get an unfamiliar user to the point where simple models can be constructed. The user can then “experiment” with the options along with later sections of this manual, to discover the extensive capabilities of this modeling software.

When executed the DMModel™ code will display the initial screen shown in Figure 3. The tabs on the left panel allow a user to set up the particular physical geometry of their mirror, conduct user-selected analyses, and investigate a wide variety of model variations.

In a general sense, the tabs can be selected in order from left to right to run through the mirror modeling effort.

First, the Specs tab is selected. The Specs tab page allows the user to establish and save a physical description of a mirror design. The default mirror design has one central actuator and 100 volts placed on the actuator pad.

Then the Membrane tab is chosen to calculate mirror Influence Functions (IF) using Finite Element Analysis (FEA) or an analytical formulation for approximate IF generation.

The Plate tab is an alternative to the Membrane tab that allows the user the capability to model the surface as a plate. Plates are generally thicker than membranes and have different bending dynamics.

The DM GUI tab means Deformable Mirror-Graphical User Interface. This screen is designed to allow the user to quickly set up the voltages on the electrostatic pads using a select-then-mouse-click technique.
The **Zernike** tab page permits the user to perform a Zernike analysis of the distorted mirror surface, after the mirror influence functions are generated. Zernike polynomials are a standard set of orthogonal functions used commonly in optical analyses to separate or break down the aberrations into easily visualized and understood distortions. Focus (spherical) and coma are two examples of Zernike functions.

The **SVD** tab allows the user to determine the orthogonal modes of the mirror by performing Singular Value Decomposition (SVD) on the generated influence functions. SVD is similar to Zernikes in the sense that it allows the designer to decompose the surface into separable, orthogonal surfaces.

The **Far-field** tab provides the user options for propagating a beam containing DM surface phase corrections into the near or far field for calculation of beam intensity diagnostics.

The **Spatial Frequency** tab allows the user to define a spatial frequency aberration and try to match that aberration using the current deformable mirror design.

The user can also select the menu options that are positioned above the tabs. These include the **File** menu which permits saving and reloading of prior cases; the **Influence Functions** menu which allows the user to save or load previously calculated influence functions; the **Materials** menu which permits loading of material properties; and the **Layout** menu which eases the user’s design and layout of the actuator pads.

The **Layout** menu is usually the first user selection on the **Specs** tab page since it greatly facilitates laying out the pad array. The pad coordinates are automatically located based on hexagonal, rectangular or ring actuator geometries with uniform pad sizing and spacing.
The screen shot in Figure 4 shows the layout of the pads after the **Create Hexagonal Actuators** menu item under the **Layout** menu was selected and three rings of pads were designed and automatically laid out. The pads are numbered and they are scaled and displayed relative to the mirror surface. The default shape is circular, but square membranes and rectangular actuators are possible with the check boxes on this page. The actuator pad locations and sizes can be changed manually with edit boxes on the lower left. Both Pad Diameter (pads are on the backplane) and Contact Diameter (the other electrostatic areas located on the back of the mirror surface) may be specified. Similarly, manual changes to pad voltages are possible. Select the **Stiff Contacts** check box when pillars are attached to the membrane surface. Descriptions of each input are displayed when the mouse is hovered over an edit box. This applies to all tab page inputs.

With the mirror design established, the next step is to define mirror influence functions using either the **Membrane** (recommended) or **Plate** tabs. The **Single FEA Solution** button will generate a FEA influence function for actuator number one. This is useful for obtaining a quick visualization of the IF structure before generating IF for all the actuators. The **FEA Influence Functions** button will generate IF for all the actuators using FEA. Approximate membrane theory may be used to obtain faster but less accurate membrane influence functions. The display in Figure 5 shows the estimated membrane displacement from actuating a single actuator using the **Single FEA Solution** button. (Note that the plot is exaggerated and inverted to facilitate visualization of the movement…the actual displacement is a depression toward the actuator pad set.) The resultant plot shows the effect on the mirror surface when actuator #1 has been set to 100 volts, which was done by default in the code initialization.
Using the 3D display option, the user has the flexibility to adjust the viewing angles by the Pitch and Spin control boxes and the Z-scale height to adjust the orientation of the plot for better viewing. After each of the adjustments, the Redraw button must be selected to display a new plot.

One useful option is to change the Display Type radio button to Interferogram, which brings up the screen in Figure 6. This plot can be directly compared to the output of a Zygo or other interferometer, or compared to the processed output from a wavefront analyzer.
The user can now opt to energize a different or larger number of actuators by selecting the DM GUI tab which brings up the screen in Figure 7. On this screen, three of the center actuators have been set to 50 volts using the mouse to select the pad of interest, then the left-mouse-click to step the voltages up to 50 volts in 10 volt increments. The user can reduce the voltages similarly using a right-mouse-click. Note that the default-set voltage on actuator #1 was reduced to zero volts.

![Figure 6 - Alternate Plot using Interferogram](image-url)
The interferogram display on the right side of this screen was generated by pressing the **Show Mirror Surface** after setting the actuator voltages. Note that influence functions must be defined before the **Show Mirror Surface** button will generate the image shown.

The following sections of this manual give more detailed descriptions of DMMModel features and capabilities.
Setting-Up a Deformable Mirror

Figure 8 shows the first tab sheet that allows the entry of the deformable mirror mechanical parameters. The first section, entitled **DM Info**, allows users to enter all the pertinent parameters of the mirror surface. The **Square** check box allows the user to select a square or circular mirror aperture. The **Stiff Contacts** check box allows the user to select a stiff-contact of the actuator to the mirror, usually implying a pillar design, like that shown in the top of Figure 1, or a non-stiff contact, like that shown in the bottom of Figure 1. The **Actuator Shape** radio buttons allows the user to select whether the actuators are rectangular or circular in cross section or are concentric rings.

The **Actuators** section allows the user to change the position, size, and voltage applied to each of the actuators. The pad size is the effective diameter of the electrostatic pad for each actuator. The contact pad is the diameter of the physical contact of the actuator to the mirror. For a standard membrane deformable mirror, shown in the top of Figure 1, these parameters are the same. For the pillared two-layer deformable mirror, the pad diameter is the size of the pillar tip nearest the electrostatic pad and the contact diameter is the size of the top of the pillar contacting the mirror surface. Clicking the **Update Changes to Memory** button must follow any changes to actuator parameters. Changes to any actuator voltage in the **Actuators** section will be reflected in the actuators drawn in the **DM GUI** tab page.

The upper right diagram shows a scaled schematic view of the deformable mirror aperture and the position, size, and shape of all the actuators. The blue lines outline the contact diameter on the mirror. The red line shows the mirror aperture. The actuator numbers are shown in green. A larger view of the design is shown in the **DM GUI** (Deformable Mirror Graphic User Interface) tab.
Quick Actuator Setup

It is possible to enter all the parameters of each actuator in the Actuators section, but it is easier to use the Layout main menu option. Under the Layout menu, there are three options: Create Rectangular Actuators, Create Hexagonal Actuators, or Create Ring Actuators. Upon selecting the Create Rectangular Actuators menu item, a dialog box will appear like that shown in the top of Figure 9, to allow the user to setup a rectangular array of actuators. The user can adjust the number of actuators in each dimension, the X and Y spacing of the actuators, the pad diameter, the contact diameter, and the shape of the actuators (either square or circular). Upon selecting the Create Hexagonal Actuators menu item, a dialog box will appear like that shown in the middle of Figure 9, to allow the user to setup a hexagonal array of actuators. The user can adjust the number of rings of hexagonal actuators about the center actuator, the spacing of the actuators, the pad diameter, and the contact diameter. Upon selecting the Create Ring Actuators menu item, a dialog box will appear like that shown in the bottom of Figure 9, to allow the user to setup an array of concentric ring actuators. The user can adjust the number of ring actuators, the spacing of the actuators, the center ring width, and the ring width. The quarter ring gap can be adjusted if the Use Quarter Ring Actuators check box is selected. This option forces each ring to be divided into quarter ring actuators with the specified gap. The total number of actuators in this case is the number of rings times four.

Loading or Saving Material Characteristics

Material parameters can be loaded or saved from the mirror using the Materials menu. Using this option allows the user to load or save the stress, Young’s modulus, Poisson’s ratio, and density from a particular mirror design. However, material parameters are also saved along with the mirror actuator pad design when the Save button is used to save the “current DM design.”

Modeling Mirror Performance

The mirror surface can be modeled as a membrane, a simply supported plate, a clamped-edge plate, or an analytical approximation to a membrane. The Membrane tab allows the user to model the mirror surface as a membrane. The Plate tab allows the user to model the mirror surface as a plate. In each case, inputs and buttons are provided to generate influence functions for one or all of the actuators in a design. The features and differences of these models are described below.
Membranes

The ideal mechanical model for a membrane assumes that the bending stresses are negligible and the dominate forces are those internal to the membrane. The surface of a membrane, \( Z(x,y) \), under tension, \( T(x,y) \), and with an applied force load, \( F(x,y) \), can be determined mathematically by solving the differential equation, \( \nabla^2 Z(x,y) = \frac{F(x,y)}{T(x,y)} \). For a circular membrane loaded at the center, an analytical solution to the membrane shape is known, but there is not an analytical solution for an off-center force loading the membrane. Therefore, the modeling software uses finite element analysis (FEA) to solve the membrane differential equation and find the surface for a given force.

Figure 10 shows the Membrane tab page. The Approx. Membrane Theory section contains buttons to generate a mirror surface or influence functions based on an approximation of the membrane theory.

The FEA Analysis section contains the options available for the user to control the finite element analysis used to determine the mirror surface based on the applied voltages. The Grid Elements option allows the user to control the size of the grid of samples used to generate the mirror surface. This size is used for every type of mirror surface. There are two different controls on the automatic termination of the finite element analysis. The iterative routine terminates when the maximum error limit is reached. If the program gets below the maximum error and the minimum number of iterations is not reached, the program continues until the minimum number of iterations is reached. In certain cases the FEA algorithm goes unstable. The program will terminate at 5000 iterations. To increase the odds of termination, the Acceleration factor should be reduced.

There are several different check boxes in the FEA Analysis section that allows the user to control different aspects of the FEA performance. The user can often increase the speed of the convergence of the FEA routine by using the approximate analytical solution as a starting point. The user can choose to see the FEA progress by specifying the number of iterations, where the default is set to 30. The user can also choose to regenerate the force (F) and tension (T) distributions using the current position of the mirror surface since the force changes due to the reduced gap between the electrodes and the tension increases due to the stretching of the mirror material. This effect is small for most common design parameters.

Plates

The ideal mechanical model for a plate assumes only a bending restoring force with no internal stress. Membranes are infinitely thin plates that do not have sufficient thickness to produce a bending restoring force. This approximation is reasonably valid only if the plate is bending less than its thickness and is under
negligible internal stress. Various plate solutions are published in Timoshenko’s *Theory of Plates and Shells* and in *Roark’s Formulas for Stress and Strain*. The modeling software uses these solutions and does not incorporate any effects of internal stresses.

**Generating Influence Functions**

All mirror influence functions are generated using the highest voltage applied to any of the actuators in a design. Designs generated using the **Layout** menu item will have actuator #1 set to 100 Volts and all other actuators set to zero. This max voltage may be changed if influence functions scaled to a higher or lower voltage are desired.

**Deformable Mirror Graphic User Interface (DM GUI)**

In a perfectly linear system, the mirror response to any set of forces can be represented as a linear superposition of the mirror influence functions. Unfortunately, non-linearity causes this not to be rigorously accurate, but for most analyses this approximation is sufficient.

The **DM GUI** tab is shown in Figure 11. The voltage on each of the actuators can be adjusted either by right or left clicking on the actuators in the image or with a pop-up window with a sliding bar based on the selection in the **Interface Mode** section. If the **Click** radio button is selected, mouse clicks allow the user to change the voltage by the value in the **Step (V)** edit box on the bottom of the screen. Right-clicks are for increasing the voltage and left-clicks are for decreasing the voltage. If the **Scan Bar** radio button is selected, a scroll bar appears when the user clicks on an actuator and the voltage can be set on the bar. An actuator can be deleted by holding down the **Ctrl** key on the keyboard and clicking the actuator.

Once the voltages are setup, the user can calculate the response of the mirror using previously generated influence functions by pressing the **Show Mirror Surface** button.

**Analysis and Characterization**

**DMModel** has many capabilities for analyzing mirror designs. These capabilities include various surface plotting routines, Zernike decomposition, resonance frequency determination, singular value decomposition, near and far-field intensity distribution analysis, and spatial frequency correction analysis.
Surface Plotting

The mirror surface can be represented as a three-dimensional rendering (Figure 12), a two-dimensional false-color rendering, or an optical interference pattern (Figure 6) as if the mirror was part of a Michelson interferometer. This gives “contour” plots where each ring is one-half wave displacement from the next. Sometimes due to resolution limitations, the plots are aliased and do not appear normal. This may be improved by increasing the mirror surface sampling under the Membrane tab. Any of three display options can be selected by using the Display Type section above the surface plot. When using the 3D plot, the Pitch, Spin, and Z-Scale boxes to the right of the Display Type section can be used to adjust the view. When using the 2D plot or the Interferogram plot, a gray-scale view can be chosen with the Gray-Scale check-box. The wavelength of the interferogram can be adjusted above the display as well. The scale can be determined via the peak-to-valley measurement shown in the upper left corner of the image in microns.

Zernike Decomposition

The Zernike tab, shown in Figure 13, allows the user to perform a Zernike decomposition of the mirror surface. The Zernike terms are numbered sequentially starting with the piston term at 0. The user can adjust the number of Zernikes that are used for the decomposition and the percent of the mirror radius that is used for the fitting since often the edges of the mirrors are typically not under control. One pictorial example is shown in Figure 14.

Selecting the Remove Terms button allows the user to fit to any set of Zernike terms and subtract them from the modeled mirror surface. Upon clicking the button, a dialog box appears with a list of the Zernike terms along with their names and a column for selecting the Zernike term to remove.

The Draw Zernike button allows the user to quickly display a Zernike term to verify its functional form and to quickly create a single Zernike term aberration for matching with a DM design. The edit boxes to the right of the button are used to specify the desired Zernike term and its magnitude.

An aberration consisting of one of multiple Zernike terms can be created using Zernike coefficient inputs accessed from the Match An Aberration with the DM section. First, click on the Setup Zernike Aberration button and enter the amplitude of each coefficient in nanometers into the Setup Aberration screen that is displayed. Then
click on the **Match Aberration with DM** button to shape the DM accordingly. To reset to the initial Zernike aberration, click on the **Reset Aberration** button. The maximum voltage for scaling the DM response is designated using the **Max Voltage for Fit** edit box. Options are also available to remove marked Zernike terms and to display the DM/aberration difference surface by selecting the appropriate check box. The root mean square wave-front error (RMSWFE) is also calculated and displayed.

**Zernike Decomposition Pictorially**

*Figure 14 - Zernike Decomposition Pictorially*

Original Deformation

Breakdown of Zernike Components
**Resonance Frequency Calculation**

The program approximates the resonance frequency of the structure by evaluating the spring constant and the mass and calculating $\sqrt{k/m}$. These results are presented in the SVD tab edit boxes when membrane and / or plate influence functions are calculated, as shown in Figure 15. Note that resonance frequency is not displayed for the Fixed-Edge and Simple-Edge plates, since these influence functions were not calculated for this case.

**Singular Value Decomposition (SVD)**

Once the influence functions are determined, the orthogonal modes of the mirror can be determined using singular value decomposition. As the SVD modes are calculated, they are displayed on the image screen. If desired, these images can be written to disk as a series of bitmap images. This is accomplished by checking the Automatic Image Save check box at the bottom of the GUI’s image display section. The gain coefficients for each mirror mode are plotted in the graph shown on the SVD tab in Figure 15. SVD is similar to Zernike decomposition in the sense that it allows the designer to decompose his surface into separable, orthogonal surfaces.

**Far-Field Intensity Profile**

The Far-field tab page, shown in Figure 16, allows the user to model the far-field intensity pattern by illuminating the mirror surface with a beam of light having a flat wave-front and propagating the beam to the far-field. The user can adjust the shape, size, and wavelength of the intensity profile incident on the mirror. The user has the choice of either a Gaussian beam or a top hat beam profile in the Intensity Profile radio button section. To obtain more detailed far-field patterns, the user can increase the number of padding bits on the near field pattern using the FFT Pad Bits edit box. The total number of bits used for the far-field calculation is displayed in the FFT Bits box. The Strehl ratio is calculated by comparing the maximum intensity of the un-aberrated far-field distribution with the maximum intensity of the aberrated far-field distribution. Image display controls are available to zoom in on the image, to invert the image colors and to apply a log scale to the image using the Zoom Factor, Invert Image and Log Scale check boxes, respectively. The near field intensity will be displayed during the calculations when the Show Near Field check box is selected.

Fresnel near to far field analysis options are also available under this tab. The user can select a single Fresnel propagation or a Fresnel scan through several propagation distances and calculate beam metrics using Fresnel Spot Analysis. The $M^2$ beam quality metric and spot size and position metrics are calculated and displayed if the Perform Spot Analysis check box is checked.
Spatial Frequency Creation and Matching

The Spatial Frequency tab allows the user to set a spatial frequency aberration. Sinusoidal spatial aberrations can be defined in the vertical and horizontal directions with specified amplitudes, spatial frequencies, and phase shift. After an aberration is defined, it can be matched with the deformable mirror using the Match Spatial Frequency with DM button. The peak-to-valley amplitudes (in nanometers) is specified in the X and Y PV Amp edit boxes. X and Y spatial frequencies (cycles/m) are also specified in edit boxes. X and Y phase shifts are specified in the % Wave Shift edit box. The limiting aperture of the spatial frequency aberration is specified in the Half-Size (um) edit box in microns. As an example, in order to fill the entire deformable mirror aperture, the half-sizes in X and Y should be half the diameter of the deformable mirror aperture. The Max Voltage for Match edit box is used to specify the maximum voltage used in match the aberration shape (similar to Max Voltage for Fit under The Zernike Tab matching options). The root mean square wavefront error (RMSWFE) is calculated when the mirror is matched to the aberration. The Remove Cylinder check box causes removal of best fit X and Y cylinder aberrations from the DM correction. The Remove Marked Zernike Terms, and Show DM/Aberration Difference check boxes are similar to those found under the Zernike tab matching options.
Main Menu Options

The main menu can be used for various options. The File menu options allow the user to save the image on the right of the screen as a bitmap, export the mirror surface to a text file, save and load mirror voltages, save and load deformable mirror parameters, print an image of the form, or exit the program. The Influence Functions menu allows the user to save and load the two-layer influence functions. The Materials menu allows the user to load and save the materials of the mirror layer. The Layout menu allows the user to automatically generate a regular rectangular, hexagonal, or concentric ring array of actuators.

Known Software Limitations

Sampling limitations may arise when there are a large number of actuators across the mirror aperture or high actuator density in a region of the mirror surface. Without enough sampling, the influence function accuracy may be limited. Another limitation arises when many waves of DM surface displacement or aberration strength is applied without sufficient sampling over the mirror aperture. In particular, this will be noticed as aliasing in the interferogram display. This may be remedied by increasing the grid element sampling under the Membrane Tab.

Figure 17 – Spatial pattern that has been created across the mirror surface.
References